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COUN	  565	  School	  Counseling	  Program	  Development	  &	  Supervision	  |	  Autumn	  2014	  
Feel free to contact me: Kate Zoellner, Education, Human Sciences, and Psychology Librarian 

243-4421 or 800-240-4939 | kate.zoellner@umontana.edu | MLIB 325 
Online Counselor Education research guide: http://libguides.lib.umt.edu/COUN 

Distance Education Library Services guide: http://libguides.lib.umt.edu/dels 
 
 
Relevant CACREP-Related Core Course Objectives: 

8.d. The principles, models, and applications of needs assessment, program evaluation, and the use of 
findings to effect program modifications. 
8.e. The use of research to inform evidence-based practice. 

 
Relevant CACREP-Related School Counseling Specialty Standards: 

I.1. How to critically evaluate research relevant to the practice of school counseling. 
I.5. Outcome research data and best practices identified in the school counseling research literature. 
J.1. How to apply relevant research findings to inform the practice of school counseling. 

 
 
KEY	  LIBRARY	  SERVICES	  FOR	  GRADUATE	  STUDENTS	  

• Interlibrary Loan and Document Delivery 
• Study Carrels 
• Bibliographic Management Software – ProQuest Flow, RefWorks, and EndNote Basic 
• Research consultations 

 
 
RESEARCH	  STRATEGIES	  
Before you begin entering terms in a database, I recommend you follow the first five steps below: 

1. Understand your research question. 
2. Identify the major concepts in your question. 
3. Identify potential terms to correspond to those concepts. 
4. Select alternative terms (narrower, broader, or related) to use if original strategy is not successful. 

In ERIC use the Thesaurus of ERIC Descriptors; in PsycINFO use Thesaurus of Psychological Index Terms. 
5. Determine logical (Boolean) relationships between terms. Boolean operators include: and, or and 

not. 
6. Begin the search. 
7. Look at a few documents. 
8. Revise & refine search based on initial results. 

 

From: Walker, G., & Janes, J. (1999). Online retrieval: A dialogue of theory and practice (2nd ed.). Englewood, CO: Libraries Unlimited. 
 

 

Break down the research statements into key concepts and synonyms. 
 

 I’m looking for articles on successful family-school collaborations. 
 

 
 I’m trying to learn more about multicultural counseling issues. 
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Too	  many	  sources	   Not	  enough	  sources	   Sources	  not	  available	  at	  the	  
Mansfield	  Library	  

  ---Ask your professor or 
librarian for assistance in 
locating locally available 
materials 
 
---Request items via 
Interlibrary Loan 

 
Cited	  Reference	  Searching	  
 
If you want to know who has cited a specific article search Web of Science or Google Scholar. PsycINFO, 
PubMed and other databases are beginning to provide ‘cited by’ data, too. 
 

 
Whiston, S. C., Tai, W. L., Rahardja, D., & Eder, K. (2011). School counseling outcome: A 
meta-analytic examination of interventions. Journal of Counseling and Development, 89(1), 37-55. 
 

• How many times has the article been cited according to Web of Science? 

• According to PsycINFO? 

• According to Google Scholar? 

	  
 

RESEARCH	  RESOURCES	  
Indexes	  
 
Dissertations & Theses, ProQuest Digital. Over 3 million dissertation and theses citations from around 
the world. Over 1.2 million available for download in PDF format; most of the dissertations added since 
1997 are available in full text. 1861-present. See also the University of Montana’s Electronic Theses, 
Dissertations and Professional Papers. 
 
ERIC (Education Resources Information Center). Over 1.4 million records covering all areas of education 
including adult, counseling, elementary and early childhood education, second-language learning, special 
education, and teacher education. Indexes journal articles, conferences, meetings, government documents, 
theses, dissertations, reports, audiovisual media, bibliographies, directories, books and monographs. 1966-
present. 
 
PsycINFO. Over 3.3 million records covering all areas of psychology, behavioral sciences, and related 
disciplines such as developmental psychology, educational psychology, psychological and physical 
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disorders, social psychology, and treatment and prevention. Indexes professional journals, chapters, books, 
reports, theses and dissertations. 1890-present. 
 
Social Services Abstracts. Over 160,450 records covering social work, human services, and related areas, 
including social welfare, social policy, and community development. Indexes over 1,300 journals as well as 
dissertations and book reviews. 1979-present. 
 
Sociological Abstracts. Over 955,000 records covering the international literature in sociology and related 
disciplines in the social and behavioral sciences. Abstracts and indexes journal articles, book reviews, 
books, book chapters, dissertations and conference papers. 1952-present. 
 
Full	  Text	  Databases	  
 
CINAHL Plus with Full Text. More than 770 journals in nursing and allied health, as well as conference 
proceedings, dissertations, and more. Most coverage is from 1981-present. 
 
Education Full Text. Full text articles from hundreds of English-language international journals, 
monographs and yearbooks. Indexing coverage from 1983-present. Abstracting coverage from 1994-
present. Full text coverage from 1996-present. 
 
Professional Development Collection. Nearly 520 education journals, including more than 350 peer-
reviewed titles, designed for professional educators. Coverage dates vary by title. 
 
PsycArticles. Over 70 journals published by APA, the APA Educational Publishing Foundation, the 
Canadian Psychological Association, and Hogrefe & Huber. Most journals are covered from the initial 
volume and issue of publication of the journal-present. 
 
Psychology and Behavioral Sciences Collection. Nearly 400 journals covering topics in emotional and 
behavioral characteristics, psychiatry & psychology, mental processes, anthropology, and observational and 
experimental methods. Coverage dates vary by title. 
 
SAGE Premier. Full-text articles from ejournals published by SAGE, multiple subjects covered. 
 
Social Sciences Full Text. Full-text articles from over 330 English-language social sciences journals. 
Indexing for 750 titles, over 670 of which are peer-reviewed titles. Coverage dates vary by title. 
	  
Taylor & Francis Social Science and Humanities Library. Full-text articles from over 1,500 humanities, 
social sciences, and science journals published by Taylor & Francis, Routledge and Psychology Press. 
 

Journals	  
 
If you are looking for a specific article (e.g., from a reference list) or a specific journal, the first step is to 
find out if the library subscribes to that journal, either online via a database or in print. Use the search box 
on the library homepage to search for the journal – choose “Journal Titles” from the “Search in” pull-
down menu. Your search results will show database access, Holdings in Ex Libris Voyager Catalog (where 
you can find a paper copy within the library), and or indicate that the library does not subscribe to the 
journal. If the library subscribes to the journal, be sure to check the dates of coverage that are available: In 
some instances historical coverage will be in print and more current content will be online. If the library 
does not have a subscription to the journal, you can request specific articles from the journal via 
Interlibrary Loan. 
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D'Esposito, S. E., Blake, J., & Riccio, C. A. (2011). Adolescents' vulnerability to peer victimization: 
Interpersonal and intrapersonal predictors. Professional School Counseling, 14(5), 299-309. 
 
Does the library provide you access to this journal title? 
 

If so, can you access the article online via the library databases? 
 

If so, can you access the article in print in the library? 
 
 
If you want to know what journals are highly regarded in your field of study, one measure is impact factor. 
You can locate journals with high impact factors in the database Journal Citation Reports. For each 
journal you will see how many articles were published in it, how many times articles from the journal were 
cited, a one-year and five-year impact factor ranking, and additional metrics. Note that JCR does not cover 
all published journals. Also note that the increased sharing of research online via blogs, faculty websites, 
institutional repositories, etc., has led individuals to develop alternative metrics for measuring scholarly 
impact (See altmetrics: a manifesto). 
 
Open	  Access	  Literature	  and	  Web	  Resources	  
 
Open-access (OA) literature is digital, online, free of charge, and free of most copyright and licensing 
restrictions. OA is a kind of access, not a kind of business model, license, or content. 
 
OA is compatible with copyright, peer review, revenue (even profit), print, preservation, prestige, quality, 
career-advancement, indexing, and other features and supportive services associated with conventional 
scholarly literature. The primary difference is that the bills are not paid by readers and hence do not 
function as access barriers. 
 
The legal basis of OA is the consent of the copyright holder (for newer literature) or the expiration of 
copyright (for older literature). Because OA uses copyright-holder consent or the expiration of copyright, 
it does not require the reform, abolition, or infringement of copyright law. The campaign for OA focuses 
on literature that authors give to the world without expectation of payment. Many OA initiatives focus on 
publicly-funded research. 
 
OA is compatible with peer review, and all the major OA initiatives for scientific and scholarly literature 
insist on its importance. The chief difference between them is that OA journals conduct peer review and 
OA repositories do not. This difference explains many of the other differences between them, especially 
the costs of launching and operating them. 
 

From: Open Access Overview, Peter Suber 

	  
DOAJ (Directory of Open Access Journals) 
Directory of open access scientific and scholarly journals that publish scholarly or review articles; exercise 
peer-review or editorial quality control; and are from academic, government, commercial, or non-profit 
private sources. DOAJ is hosted and maintained by Lund University Libraries, Sweden. 
 
In addition to subscription and open access scholarly publications, material on professional association 
(e.g., American School Counselor Association) individual researchers’, and research centers’ (e.g., Ronald 
H. Fredrickson Center for School Counseling Outcome Research & Evaluation - CSCORE) websites 
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provide sources for your research. And for Action Plan Project in this course Prof. Nichols recommends 
in the syllabus the following free online resources: 

• Montana Office of Public Instruction 
• National Center for Education Statistics 

 
 
KEEP	  CURRENT	  
Current Awareness Services help you keep on top of what is being published in your research area, or by 
specific authors or in specific journals, by automating research practices. These services are provided free 
by most publishers and database vendors, and some search engines and universities; often they require 
registration. You can select how often to be updated (e.g., monthly) and how, usually options are via email 
or a RSS feed. Below are examples of current awareness services. Find out more on the Keeping Current 
online guide. 

• Table of Contents Alerts. Receive an alert each time a new issue of a journal is published. 
(JournalTOCs is a website service through which you can sign up for multiple alerts.) 

• Saved Search Alerts. Receive notice when new articles come into a database that fit your search 
query. 

• Cited Reference Alerts. Receive notice when a new publication cites a particular article or text. 
• News alerts. Receive alerts from newspapers, government institutes, etc.; anywhere you see the 

RSS icon. 
• Google and Yahoo! Alerts. Set up a search query and have the results emailed to you. 
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MANAGE	  YOUR	  RESEARCH	  
Streamline the management of your research by using a citation management tool. The library provides 
subscription access to two such web-based tools, EndNote Basic and RefWorks. There is also a new 
program called ProQuest Flow (developed by the same company that developed and provides RefWorks). 
These tools are most helpful if you are working on research involving many citations (more than 20) or 
ongoing projects like a manuscript, thesis, or dissertation. You can use all tools to: 

• create your own personal database to keep track of your research articles, documents, websites, 
etc.; 

• automatically generate a bibliography in a variety of styles (e.g., APA, ASA, Chicago, MLA); 
• add in-text citations to Word documents; and 
• share your research sources. 

 
Flow additionally allows you to annotate documents, drag and drop pdf files into the system from which 
metadata is automatically drawn, and import existing libraries (e.g., RefWorks, Mendeley). ProQuest 
representatives will be offering a training session on Flow titled, “Organizing, annotating, and citing your 
digital references” on Thursday, October 23 from 4-5pm in the library’s Student Learning Center (283). 
 
The table below provides basic information to get you started using RefWorks. 
 

	   RefWorks	  

Access	   Click the “Databases” link on the homepage, the “R” tab, then “RefWorks.” 

Set	  up	  an	  
account	  

Use your official UM email address. Off-campus access requires a Group Code that will be sent to 
you when you set up your account, and can be re-sent to you if you send an email from your UM 
email to refworks@umontana.edu. 

Add	  
citations	  

Click the “References” menu, then “Add New”. You can also add citation data from various 
databases, usually under “Export” or “Save Citations.” In some instances this is seamless (e.g., using 
CSA databases), in other instances you will need to download the data and then use the “Import” 
option under the “References” menu. 

Organize	  
citations	  

Select the “New Folder” button to add a new folder. A citation can be placed in more than one 
folder. Select the “Organize & Share Folders” tab to make changes. Folders can be shared with both 
RefWorks and non-RefWorks account holders via email, URL, or in UM’s RefWorks RefShare area. 

Find	  
citations	  in	  
your	  account	  

Use the “Search” box. Citations can also be viewed by author, journal/periodical, or 
subject/descriptor by selecting “Search” menu. 

Create	  
in-‐text	  
citations	  

Requires you to download a utility program to your computer called “Write-N-Cite” that works 
with most MS Word programs. Find the utility under the “Tools” menu. 
 
If you want to use ProQuest’s Flow you should download the “ProQuest for Word” plugin that 
works with both RefWorks and Flow. 

Create	  a	  
Bibliography	  

Use the “Bibliography” menu or “Create Bibliography” button. 

Get	  help	   RefWorks tutorials. A “Help” menu is available in RefWorks. 
 
Note: Most database, journal, and publically available resource descriptions were taken verbatim from publisher and organization web sites. 


